Thank you for purchasing the LW2310 wireless video monitoring system.
This manual refers to the following model(s):

- LW2310 Series

To learn more about this product and to learn about our complete range of accessory products, please visit our website at:

www.lorextechnology.com

---

CAUTION

RISK OF ELECTRIC SHOCK
DO NOT OPEN

CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK DO NOT REMOVE COVER. NO USER SERVICABLE PARTS INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

The lightning flash with arrowhead symbol, within an equilateral triangle, is intended to alert the user to the presence of uninsulated “dangerous voltage” within the products ` enclosure that may be of sufficient magnitude to constitute a risk of electric shock.
The exclamation point within an equilateral triangle is intended to alert the user to the presence of important operating and maintenance (servicing) instructions in the literature accompanying the appliance.

WARNING: TO PREVENT FIRE OR SHOCK HAZARD, DO NOT EXPOSE THIS UNIT TO RAIN OR MOISTURE.

CAUTION: TO PREVENT ELECTRIC SHOCK, MATCH WIDE BLADE OF THE PLUG TO THE WIDE SLOT AND FULLY INSERT.
Need Help?
CONTACT US FIRST

DO NOT RETURN THIS PRODUCT TO THE STORE

Please make sure to register your product at www.lorextechnology.com to receive product updates and information.

3 Easy Ways to Contact Us:

Online:
Product Support is available 24/7 including product information, user manuals, quick start up guides and FAQ’s at www.lorextechnology.com/support
To order accessories, visit www.lorextechnology.com

By Email:
Technical Support (for technical/installation issues) support@lorexcorp.com
Customer Care (for warranty and accessory sales) customerservice@lorexcorp.com
Customer Feedback info@lorexcorp.com

By Phone:
North America:
Customer Service: 1-888-425-6739 (1-888-42-LOREX)
Tech Support: 1-877-755-6739 (1-877-75-LOREX)
Mexico: 1-800-514-6739
International: +800-425-6739-0
(Example: From the UK, dial 00 instead of +)
3 maneras sencillas de comunicarse con nosotros:

En línea:
apoyo al producto disponible 24/7 incluyendo información del producto, manuales para el usuario, guías de inicio rápido y preguntas más frecuentes en

www.lorextechnology.com/support

Para colocar pedidos de accesorios, visite

www.lorextechnology.com

Por Correo Electrónico:
soporte técnico (para asuntos técnicos/la instalación)
support@lorexcorp.com
O
servicio al cliente (respecto a la garantía y a la venta de accesorios)
customerservice@lorexcorp.com

Comentarios de cliente
info@lorexcorp.com

Por Teléfono:
Norte América:
Atención al cliente: 1-888-425-6739 (1-888-42-LOREX)
Soporte técnico: 1-877-755-6739 (1-877-75-LOREX)
México: 1-800-514-6739
Internacional: +800-425-6739-0
(Ejemplo: Desde el Reino Unido, marque el 00 en lugar del +)

En ligne:
le support des produits est disponible 24 heures sur 24, 7 jours sur 7, y compris les informations sur les produits, les guides de l’utilisateur, les guides de démarrage rapide et les foires à questions

www.lorextechnology.com/support

Pour commander des accessoires, visitez

www.lorextechnology.com

Par Courriel:
support technique (pour les questions techniques et ‘installation) support@lorexcorp.com
OU
service à la clientèle (pour les questions de garantie et les ventes d’accessoires)
customerservice@lorexcorp.com

Commentaires des clients
info@lorexcorp.com

Par Téléphone:
L’Amérique du Nord:
Service à la clientèle: 1-888-425-6739 (1-888-42-LOREX)
Support technique: 1-877-755-6739 (1-877-75-LOREX)
Mexique: 1-800-514-6739
International: +800-425-6739-0
(Exemple: À partir du Royaume-Uni, composez 00 au lieu de +)
LOREX IS COMMITTED TO FULFILLING YOUR SECURITY NEEDS

- We have developed user friendly products and documentation. Please read the Quick Start Guide and User Manual before you install this product.

- Consumer Guides and Video Tutorials are available on our website at www.lorextechnology.com/support

- If you require further installation assistance, please visit www.lorextechnology.com/installation or contact a professional installer.

- Please refer to the “Need Help” insert for technical support and customer care information.

- Please note that once the components of this product have been unsealed, you cannot return this product directly to the store without the original packaging.
CE PRODUIT POURRAIT EXIGER UNE INSTALLATION PROFESSIONNELLE

• Veuillez lire le guide de démarrage rapide et le mode d’emploi avant d’installer ce produit

• Les guides du consommateur et les séances de tutorat vidéo sont disponibles sur l’Internet en visitant www.lorextechnology.com/support

• Si vous avez besoin de l’aide pour l’installation, veuillez visiter www.lorextechnology.com/installation ou contactez un spécialiste en installation

• Veuillez référer à l’insert “Need Help” pour obtenir de l’information sur le service à la clientèle et le support technique

• Veuillez constater qu’une fois que les composantes de ce produit ont été retirées de l’emballage, vous ne pourrez plus retourner ce produit directement au magasin

www.lorextechnology.com
**Important Safeguards**

In addition to the careful attention devoted to quality standards in the manufacture process of your product, safety is a major factor in the design of every instrument. However, safety is your responsibility too. This sheet lists important information that will help to ensure your enjoyment and proper use of the product and accessory equipment. Please read them carefully before operating and using your product.

**General Precautions**

1. All warnings and instructions in this manual should be followed.
2. Do not use receivers or video monitors in humid or wet places.
3. Keep enough space around the product for ventilation. Slots and openings in the storage cabinet should not be blocked.
4. It is highly recommended to connect the product to a surge protector to protect from damage caused by electrical surges. It is also recommended to connect the product to an uninterruptible power supply (UPS), which has an internal battery that will keep the product running in the event of a power outage.
5. Remove the plug from the outlet before cleaning. Do not use liquid aerosol detergents. Use a water dampened cloth for cleaning.

**Installation**

1. **Read and Follow Instructions** - All the safety and operating instructions should be read before the product is operated. Follow all operating instructions.
2. **Retain Instructions** - The safety and operating instructions should be retained for future reference.
3. **Heed Warnings** - Comply with all warnings on the product and in the operating instructions.
4. **Polarization** - Do not defeat the safety purpose of the polarized or grounding-type plug.
   - A polarized plug has two blades with one wider than the other.
   - A grounding type plug has two blades and a third grounding prong.
   - The wide blade or the third prong are provided for your safety.
   - If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.
5. **Power Sources** - This product should be operated only from the type of power source indicated on the marking label. If you are not sure of the type of power supplied to your location, consult your video dealer or local power company. For products intended to operate from battery power, or other sources, refer to the operating instructions.
6. **Overloading** - Do not overload wall outlets or extension cords as this can result in the risk of fire or electric shock. Overloaded AC outlets, extension cords, frayed power cords, damaged or cracked wire insulation, and broken plugs are dangerous. They may result in a shock or fire hazard. Periodically examine the cord, and if its appearance indicates damage or deteriorated insulation, have it replaced by your service technician.

7. **Power-Cord Protection** - Power supply cords should be routed so that they are not likely to be walked on or pinched by items placed upon or against them. Pay particular attention to cords at plugs, convenience receptacles, and the point where they exit from the product.
8. **Surge Protectors** - It is highly recommended that the video equipment be connected to a surge protector. Doing so will protect the equipment from damage caused by power surges. Surge protectors should bear the UL listing mark or CSA certification mark.
9. **Uninterruptible Power Supplies (UPS)** - Because this product is designed for continuous, 24/7 operation, it is recommended that you connect the product to an uninterruptible power supply. An uninterruptible power supply has an internal battery that will keep the product running in the event of a power outage. Uninterruptible power supplies should bear the UL listing mark or CSA certification mark.

**Caution:** Maintain electrical safety. Power line operated equipment or accessories connected to this product should bear the UL listing mark or CSA certification mark on the accessory itself and should not be modified so as to defeat the safety features. This will help avoid any potential hazard from electrical shock or fire. If in doubt, contact qualified service personnel.
Installation (Continued)

10. **Ventilation** - Slots and openings in the case are provided for ventilation to ensure reliable operation of the product and to protect it from overheating. These openings must not be blocked or covered. The openings should never be blocked by placing the video equipment on a bed, sofa, rug, or other similar surface. This product should not be placed near or over a radiator or heat register. This product should not be placed in a built-in installation such as a bookcase or rack unless proper ventilation is provided and the product manufacturer’s instructions have been followed.

11. **Attachments** - Do not use attachments unless recommended by the product manufacturer as they may cause a hazard.

12. **Water and Moisture** - Do not use receivers or video monitors near water — for example, near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet basement, near a swimming pool and the like.

13. **Heat** - The product should be situated away from heat sources such as radiators, heat registers, stoves, or other products (including amplifiers) that produce heat.

14. **Accessories** - Do not place this video equipment on an unstable cart, stand, tripod, or table. The video equipment may fall, causing serious damage to the product. Use this product only with a cart, stand, tripod, bracket, or table recommended by the manufacturer or sold with the product. Any mounting of the product should follow the manufacturer’s instructions and use a mounting accessory recommended by the manufacturer.

15. **Camera Extension Cables** – Check the rating of your extension cable[s] to verify compliance with your local authority regulations prior to installation.

16. **Mounting** - The cameras provided with this system should be mounted only as instructed in this guide or the instructions that came with your cameras, using the provided mounting brackets.

17. **Camera Installation** - Cameras are not intended for submersion in water. Not all cameras can be installed outdoors. Check your camera environmental rating to confirm if they can be installed outdoors. When installing cameras outdoors, installation in a sheltered area is required.

Service

1. **Servicing** - Do not attempt to service this video equipment yourself, as opening or removing covers may expose you to dangerous voltage or other hazards. Refer all servicing to qualified service personnel.

2. **Conditions Requiring Service** - Unplug this product from the wall outlet and refer servicing to qualified service personnel under the following conditions:
   
   A. When the power supply cord or plug is damaged.
   
   B. If liquid has been spilled or objects have fallen into the product.
   
   C. If the product has been exposed to rain or water.
   
   D. If the product has been dropped or the cabinet has been damaged.
   
   E. If the product does not operate normally by following the operating instructions. Adjust only those controls that are covered by the operating instructions. Improper adjustment of other controls may result in damage and will often require extensive work by a qualified technician to restore the product to its normal operation.
   
   F. When the product exhibits a distinct change in performance. This indicates a need for service.

3. **Replacement Parts** - When replacement parts are required, have the service technician verify that the replacements used have the same safety characteristics as the original parts. Use replacements specified by the product manufacturer can prevent fire, electric shock, or other hazards.

4. **Safety Check** - Upon completion of any service or repairs to this product, ask the service technician to perform safety checks recommended by the manufacturer to determine that the product is in safe operating condition.

Use

1. **Cleaning** - Unplug the product from the wall outlet before cleaning. Do not use liquid cleaners or aerosol cleaners. Use a damp cloth for cleaning.

2. **Product and Cart Combination** - Product and cart combination should be moved with care. Quick stops, excessive force, and uneven surfaces may cause the product and cart combination to overturn.

3. **Object and Liquid Entry** - Never push objects of any kind into this product through openings as they may touch dangerous voltage points or “short-out” parts that could result in a fire or electric shock. Never spill liquid of any kind on the product.

4. **Lightning** - For added protection of this product during a lightning storm, or when it is left unattended and unused for long periods of time, unplug it from the wall outlet and disconnect the antenna or cable system. This will prevent damage to the product due to lightning and power line surges.
WARNING

This product contains a button battery. If swallowed, it could cause severe injury or death in just two hours. Seek medical attention immediately.

**STRANGULATION HAZARD:** Infants have STRANGLED in power cords. Keep power cords more than 3 feet away from cribs, bassinets, play yards, and other safe sleep environments for infants.

NOTICES

**FCC Notice:**
This equipment has been certified and found to comply with the limits regulated by the FCC part 15, subpart C. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications.

However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception (which can be determined by turning the equipment on and off), the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna
- Increase the separation between the equipment and receiver
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected
- Consult the dealer or an experienced radio or television technician for assistance

**Warning:**
To ensure compliance with the FCC’s RF exposure guidelines, this equipment should be installed and operated with minimum distance 20cm (7.87in) between the radiator and nearby persons.

**Industry Canada Notice:**
This device complies with Industry Canada licence-exempt RSS standard[s]. Operation is subject to the following two conditions: (1)This device may not cause harmful interference, and (2)This device must accept any interference received, including interference that may cause undesirable operation.

This Class B digital apparatus complies with Canadian ICES-003.

Le présent appareil est conforme aux CNR d’Industrie Canada applicables aux appareils radio exempts de licence. L’exploitation est autorisée aux deux conditions suivantes : (1) l’appareil ne doit pas produire de brouillage, et (2) l’utilisateur de l’appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d’en compromettre le fonctionnement.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.

**MODIFICATION:**
Any changes or modifications not expressly approved by the grantee of this device could void the user’s authority to operate the device.

Toute modification non approuvée explicitement par le fournisseur de licence de l’appareil peut entraîner l’annulation du droit de l’utilisateur à utiliser l’appareil.

**RoHS:**
This product is fully compliant with the European Union Restriction of the Use of Certain Hazardous Substances in Electrical and Electronic Equipment (“RoHS”) Directive (2002/95/EC). The RoHS directive prohibits the sale of electronic equipment containing certain hazardous substances such as lead, cadmium, mercury, and hexavalent chromium, PBB, and PBDE in the European Union.
Features

Receiver Features

- Connect the receiver to a computer to view from anywhere in the world using Skype™*
- Simple installation. No video cables required ready for basic remote connectivity* 1
- Integrated digital video recorder, SD™ memory card included
- Multiple recording options: manual, motion or schedule 2
- Time and date stamped recordings for easy retrieval
- Night viewing up to 40ft (12m) 3
- View up to 4 cameras at the same time or in sequence
- Up to 150ft indoor/450ft outdoor wireless range 5
- Tabletop, wall or under-counter mountable receiver

Camera Features

- VGA (640x480) resolution camera
- IR Night Vision up to 40ft/12m 3
- Install cameras indoors or outdoors 4
- IR Cut Filter for accurate color reproduction under all lighting conditions
- Built-in PIR motion sensor for accurate motion detection
- Durable indoor/outdoor housing ideal for indoor/outdoor use 4
- SMA connector allows for the usage of higher power antennas to extend wireless range (antennas sold separately).

1. Cameras require a local power outlet.
2. Local viewing up to 4 cameras simultaneously. Local recording and playback of one camera at a time.
3. Stated IR Illumination range is based on ideal conditions. Actual range and image clarity depends on installation location, viewing area and light reflection/absorption level of object.
4. Weather resistant. Not intended for direct exposure to rain or snow. For outdoor applications install under shelter protected from the elements.
5. Based on line of sight. Actual range will vary depending on obstructions.

* Remote connection requires driver installation on home PC/Mac (CD included/latest drivers available from www.lorextechnology.com), a wired USB connection between the receiver and PC/Mac (USB cable included) and a high-speed Internet connection.

- Computer must be turned ON and Skype™ application must be running. Remote viewing is limited to a single camera and is not selectable remotely.
# Table of Contents

## Getting Started
- Wireless Receiver overview ....................................................... 2
- Camera overview ........................................................................ 4
- Remote Control .......................................................................... 5

## Installing the camera
- Connecting the Wireless Receiver ............................................... 8
- LED Indicators on the Wireless Receiver ...................................... 9

## Using the System
- Understanding the on-screen display ........................................... 10
  - About the Status Indicator .......................................................... 11
- Viewing Modes ........................................................................... 12
  - Quad mode .................................................................................. 12
- Setting the time ........................................................................... 13

## Recording
- Recording Mode Summary ............................................................ 14
  - Manual Recording ..................................................................... 15
  - Schedule Recording .................................................................. 15
    - Stopping Schedule Recording ......................................................... 16
  - Motion recording ....................................................................... 17
- Viewing Recorded Video ............................................................... 18
  - Viewing Video Using the System .................................................. 18
  - Controlling Playback .................................................................. 18
  - Viewing Video Directly From the SD Card .................................... 19

## Using the Main Menu
- Camera On/Off .......................................................................... 20
  - Record ....................................................................................... 20
    - Quality ..................................................................................... 21
    - Record Time ........................................................................... 21
    - Schedule Record ...................................................................... 21
    - Overwrite ................................................................................ 22
- Pairing ......................................................................................... 22
- Settings ........................................................................................ 23
  - Date & Time .............................................................................. 24
  - Brightness ................................................................................ 24
  - AV Out ....................................................................................... 25
  - Zoom ........................................................................................ 25
  - Format ....................................................................................... 26
  - Factory Reset ............................................................................ 26

## Appendix A: System Specifications .............................................. 27
Getting Started

The system includes the following components:

- Outdoor camera*
- Wireless receiver
- Remote Control
- SD Memory card**
- Power adapter(s) for receiver and camera(s)*
- Audio/video cable
- Mounting kit(s)*
- Camera mounting stand*
- IR Extender*
- Wireless antennas (for camera and receiver)*
- USB cable
- Software CD

*Configuration may vary by model.
**Optional SD card. Consult your package for content details.

CAMERA CONFIGURATION, AND NUMBER OF ACCESSORIES MAY VARY BY MODEL. PLEASE REFER TO YOUR PACKAGE FOR SPECIFIC DETAILS. CHECK YOUR PACKAGE TO CONFIRM THAT YOU HAVE RECEIVED THE COMPLETE SYSTEM.
Wireless Receiver overview

Top Panel

1 **Wireless Antenna**: Position the antenna as needed for best reception.

2 **CHANNEL**: Press M to change channels 1~4 manually; press A to enable Auto Sequence Viewing Mode.

3 **RECORD**: Press M to start Manual Recording; press M again to stop. Press A to start Motion Recording; press A again to stop.

4 **LED Indicators**: LED indicators for camera and receiver operations. For details, see "LED Indicators on the Wireless Receiver" on page 9.

5 **Channels, OK**: QUAD MODE ONLY-Press 1 to view camera 1, 2 to view camera 2, 3 to view camera 3, and 4 to view camera 4; press OK to enter/confirm menu selections.

6 **Quad**: Press to change display view to Quad (4-way); press again to exit.

7 **MENU**: Press to open the Main Menu, cancel/exit, or go to the previous page.

8 **Del.**: Press to delete files on the SD card.
1 **Antenna port**: Connect an antenna to the antenna port.

2 **DC**: Connect the included power adapter.

3 **AV Out**: Connect the included Audio/Video cable to display images from the receiver on your TV/monitor.

4 **USB Port**: Connect a USB cable from your computer to the receiver to enable Skype connectivity. For details, see “Appendix H: Viewing your camera remotely using Skype on a PC” on page 35.

5 **Alarm Vol.**: Adjust the volume of the motion alarm; will also adjust volume of system “beeps” when you press buttons on the receiver and remote control.

6 **IR Extension**: Connect the included IR extender (optional).

7 **Lock**: Slide the button to the right to lock the buttons on the wireless receiver. Slide the button to the left to unlock the buttons.

8 **SD Card**: Insert an SD card (max 16 GB) to save recorded video files.
Camera overview

1 Lens: Camera lens.
2 Microphone: Built-in microphone underneath camera body.
3 PIR Sensor: Passive IR motion sensor for more accurate motion recording.
4 Night Vision IR: Night vision IR LEDs used for viewing in complete darkness.
5 Pair: Pairing button. For more details, see “Appendix C: Adding Cameras” on page 29.
6 Antenna: Wireless antenna.
7 Power Cable: Connect the included power adapter to the cable extending from the camera.

**ATTENTION**
This camera includes an Auto Mechanical IR Cut Filter. When the camera changes between day/night lighting, an audible clicking noise may be heard coming from the camera. This clicking is normal, and indicates that the camera filter is working.
Remote Control

**Important**
You must connect the IR extender to the receiver before you can use the remote. To use the remote, point the remote to the general direction of the IR extender to control the receiver.

1. **1 / ▶ / ▪ / ▼**: Move menu cursor UP; change time settings; start/pause playback; jump to camera 1 while in Quad Mode.
2. **Enter**: Confirm menu selections.
3. **4 / ◀**: Move menu cursor LEFT; rewind playback; jump to camera 4 while in Quad Mode; decrease
4. **MENU / Back**: Press to open the Main Menu; close menu windows.
5. **Record**: Press **Motion** to enable motion recording - system will ONLY record when motion is detected; press ● to start/stop manual recording.
6. **Volume**: Increase/decrease volume during playback.
7. **Quad**: Press to change the display view to quad (4-way) split-screen.
8. **2 / ▶**: Move menu cursor RIGHT; increase playback speed; jump to camera 2 while in Quad Mode; increase values in certain menu options.
9. **3 / ◀**: Move menu cursor DOWN; change time settings; stop playback; jump to camera 3 while in Quad Mode.
10. **Scan/Del**: Press to enable/disable Screen Saver mode; delete recorded video files.
11. **Channel**: Press "A" to enable/disable automatic sequence; press **M** to manually change the channels (1~4).
12. **AV**: Press to send the image to a connected TV or monitor (AV cable required)

**NOTE**: Unless otherwise noted, button names mentioned in steps in this manual will refer to buttons on the remote control.

You must connect the IR extender to the receiver before you can use the remote. To use the remote, point the remote to the general direction of the IR extender to control the receiver.
Installing the camera

Before you install the camera, plan where and how it will be positioned, and where you will route the cable that connects the camera to the power adapter.

- Before starting permanent installation, verify its performance by observing the image on a monitor when camera is positioned in the same location/position where it will be permanently installed.

- The cameras are pre-paired so they work out of the box. Each camera has a channel number sticker indicating what channel they are paired to. To manually pair your cameras, see “Appendix C: Adding Cameras” on page 29.

**Installation Warnings**

- Mount the camera indoors or outdoors. For outdoor installation, mount it in a sheltered place where it is not directly exposed to rain or snow.
- Aim the Cameras to best optimize the viewing area: Select a location for the camera that provides a clear view of the area you want to monitor, which is free from dust, and is not in line-of-sight to a strong light source or direct sunlight.
- Place the camera within 21 feet (6.5 meters) of the area you wish to monitor for motion during night time. This allows for optimal motion detection.
- Avoid installing the cameras where there are thick walls or obstructions between the Cameras and the Receiver.
- Select a location for the camera that has an ambient temperature between 14°F~122°F (-10°C ~ 50°C).

**To install the camera**

1. Use the included mounting screws to mount the stand to the mounting surface:
   - Mark the position of the screw holes on the wall
   - Drill holes and insert the drywall plugs as needed
   - Firmly attach the stand to the wall using the provided screws
2 Twist the antenna clockwise onto the antenna port on the side of the camera.

3 Attach the camera to the mounting stand. Adjust the angle of the camera until the desired view is set. Tighten the thumbscrews to secure the desired camera position.

4 Connect the black power cable extending from the camera to the cable of the power adapter; plug in the power adapter to an outlet or surge protector.

**NOTE:** You can install additional cameras (maximum of 4 cameras). When adding cameras that were not included in the original box, you will need to pair the cameras with the receiver. For details, see “Appendix C: Adding Cameras” on page 29.
Connecting the Wireless Receiver

To set up the wireless receiver:

1. Twist the antenna clockwise onto the antenna port. Do not over tighten.

2. Connect the Black cable from the AV cable to the AV Out port of the receiver. Connect the Yellow video cable and White audio cable (mono) to your TV, DVR, or observation system.

3. Connect the cable from the power adapter to the 9V DC port, and then connect the power adapter to an outlet or surge protector.

4. Insert the included SD card into the SD Card slot on the right panel of the receiver until you hear a "click."

**NOTE:** The receiver is compatible with most major brands of SD card up to 16 GB. For recording times on SD cards, see “Appendix F: Estimated Recording Times on SD Cards” on page 33.

5. Place the receiver in an area that will have a clear reception to your camera.
   - Avoid installing the receiver which requires the wireless signal to pass through cement, concrete, and metal structures. This will reduce the range of transmission.

6. Change the video input on your TV or monitor to the corresponding input of the video cable (i.e. Video 1, Video 2, Auxiliary, etc.).

**OPTIONAL:** Connect the included IR extender to the IR Extend port. Use the IR extender to hide the receiver from plain sight. You can conceal the sensor of the IR Extender and still fully control the system using the included remote control.
LED Indicators on the Wireless Receiver
Use the LED indicators on the wireless receiver to observe the status of the receiver, cameras, and SD card.

The blue LEDs indicate the following:
1  MANUAL: Channel switching set to manual
2  AUTO: Channel switching set to Auto - Auto Sequence Viewing Mode enabled
   NOTE: By default, Auto Sequence Viewing Mode is enabled when you first power on the wireless receiver.
3  M: Manual recording enabled
4  A: Motion recording enabled
5  NEW: A new video file has been recorded to the SD card
6  FULL: The SD card is full
   NOTE: The “Full” light will only appear if Overwrite is disabled. For details, see “Overwrite” on page 22.
Using the System

By default, the camera included with your system is automatically paired to the wireless receiver. The camera and receiver will communicate with each other once they are powered on.

Understanding the on-screen display

With camera 1 properly connected and powered on, the system displays a single channel full-screen live view of the camera.

**NOTE:** Power on the cameras before powering on the receiver.

1. **File Name:** The name of the file actively being recorded. This file will appear in the file list on the SD card. The Recording File stamp indicates the hour, minutes, and seconds that the system started recording.

```
160602-2.AVI
```

- **Hour** (24-hour)
- **Seconds**
- **File extension [.AVI]**
- **Minute**
- **Camera number**
2 **Signal Indicator:** The signal indicator shows the strength of the signal being received from the camera. The number of bars in the Signal Indicator shows the strength of the signal. One, or no bars indicates the signal is poor, and 4 bars indicate a very strong signal. The signal indicator is not shown during quad mode.

**NOTE:** If the signal is low (e.g. 1 or 2 bars) adjust the antennas, or reposition the cameras or receiver for best performance.

3 **Recording Indicator:** “REC” appears during manual, motion, and schedule recording.

4 **SD Card icon:** A white “SD” icon displays that an SD card is in the wireless receiver.

5 **Power Failure icon:** Flashing icon indicates a power failure has occurred on the system. You may need to manually restore settings or modes on the system after a power failure. For details, see “Appendix G: Power Failure Indicator” on page 34.

6 **File Icon:** Flashes yellow when writing data to the SD card. Flashes red when the SD card is full.

![SD card icons](image)

7 **Camera indicator:** Displays the camera you are presently viewing; position of camera indicators shifts to the left side of the screen while in Quad mode.

8 **Time Stamp:** The current date and time on the system.

---

**About the Status Indicator**

The status indicator message “Connecting” appears when the receiver is trying to locate a camera.

**NOTE:** There may be temporary signal losses for less than 1 second, due to the connection retrieval process between the Camera and Receiver (when switching between channels). This is a normal operation of the receiver.
Viewing Modes
There are four different viewing modes available on the system: single channel viewing, Auto Sequence Viewing Mode (view individual channels automatically in sequence), Quad mode, and Screen Saver Mode.

To change viewing modes:
1 Press the Channel A button on the remote to enable Auto Sequence Viewing Mode and switch automatically between channels.
2 Press the Channel M button on the remote to disable Auto Sequence.

OR
1 Press the Channel M button on the remote repeatedly to switch between channels 1~4

NOTE: By default, Auto Sequence Viewing Mode is enabled when you first power on the system, and when you exit Screen Saver mode.

Quad mode
Use Quad mode to view up to four cameras simultaneously.

To enable/disable quad mode:
1 Press the QUAD button on the remote. The Schedule Recording warning appears briefly on-screen, then the Quad display mode begins.

NOTE: You cannot access the Main Menu or turn on Schedule recording while the system is in Quad Mode.

NOTE: Quad mode is also available while in Zoom mode. For details on using Zoom, see “Zoom” on page 25.

NOTE: Using Quad Mode with Motion Recording is a highly recommended recording solution. For more details, see “Motion recording” on page 17.
Setting the time

It is highly recommended to set the time on the system prior to recording. You need to set the correct date and time in order to use Schedule Recording. For more details, see “Motion recording” on page 17.

To set the time:

1. From the Main Menu, select Setting and press the Enter button on the remote.
2. From the Setting menu, select Date & Time and press the Enter button on the remote.
3. Press RIGHT/LEFT to move the cursor; press UP/DOWN to change the year, month, day, hour, minutes, and seconds.
   
   NOTE: The system uses a 24-hour clock.
4. Press Enter on the remote to save your settings.
5. Press MENU on the remote to close any remaining menu windows.

   NOTE: There no daylight savings time (DST) setting on the system. DST must be set manually if necessary.
Recording

Three recording modes are available on the system: Manual Recording, Schedule Recording, and Motion Recording.

**NOTE:** The system can record video to an SD card one channel at a time.

**Prerequisites**
1. An SD card must be inserted in the wireless receiver in order to record. You should always format the SD card prior to initial recording. For details, see “Format” on page 26.
2. Recording overrides other actions on the receiver. You must stop recording on the system in order to perform other actions, such as opening the Main Menu, Quad Mode, etc.

**Recording Mode Summary**

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MANUAL RECORDING</td>
<td>• Continuous recording from one camera&lt;br&gt;• Press the Record button ( ● ) on the remote control to start/stop manual recording&lt;br&gt;• Cannot record while in Quad mode&lt;br&gt;• Cannot record while in Auto Sequence Viewing Mode</td>
</tr>
<tr>
<td>SCHEDULE RECORDING</td>
<td>• Continuous recording from one camera or from Auto Sequence Viewing Mode (system will record from one camera at a time)&lt;br&gt;<strong>ATTENTION:</strong> Turn off Manual Recording and Motion Recording to enable Schedule Recording&lt;br&gt;• Enter a Start and Stop Time from Main Menu → Record → Schedule Record&lt;br&gt;• Cannot enable Schedule Recording while in Quad Mode&lt;br&gt;• Cannot record while in Screen Saver Mode (i.e. if the system is in Screen Saver Mode, Schedule Recording will be disabled)</td>
</tr>
<tr>
<td>MOTION RECORDING [AUTO]</td>
<td>• System only records when motion is detected by a camera&lt;br&gt;• Compatible with Quad Mode (recommended)&lt;br&gt;• Compatible with Auto Sequence Viewing Mode&lt;br&gt;• Press the Motion button on the remote to start/stop Motion Recording</td>
</tr>
</tbody>
</table>
Manual Recording

Manual Recording allows you to manually start/stop recording from one channel at a time. You cannot record while in Quad mode.

You can also record while in Zoom mode. For details on using Zoom, see “Zoom” on page 25.

**NOTE:** You cannot change channels or enable Auto Sequence Viewing Mode during Manual Recording.

**To enable Manual recording:**
1. Select a channel (1~4) on the wireless receiver or from the remote control.
2. Press the Record button (●) on the remote control. A blue LED will light up under RECORD—M on the wireless receiver.
3. To stop Manual Recording, press the Record button (●) again.

**When Should I Use Manual Recording?**
- Emergency recording
- Low traffic environments

Schedule Recording

Use Schedule Recording to have the system automatically record continuously from a selected camera, or from Auto Sequence Viewing Mode according to a start and stop time.

**NOTE:** You must set a Recording Schedule in the main menu in order to use Schedule Recording.

**NOTE:** Auto Sequence is available during Schedule Recording. However, the system will record video of the sequence itself. Therefore you cannot playback video of individual cameras.

**Prerequisite:**
Please ensure you have set the date and time on the receiver prior to setting a recording schedule.

**Step 1 of 2: Set a recording schedule**
1. Press the **MENU** button on the remote to open the Main Menu.
2. Select **Record** and press the **Enter** button.
3. Using the remote, press RIGHT/LEFT to move the cursor (yellow); press UP/DOWN to change the hour and the minutes.
NOTE: You need to press RIGHT to move the cursor from Start Time to Stop Time.

4 Press the Enter button on the remote to save your schedule.

5 Press MENU on the remote until all menu windows are closed.

NOTE: You cannot enable Schedule Recording if the system is in Quad Mode.

Step 2 of 2: Enable schedule recording

1 Disable ALL RECORDING on the system:
   • If the system is in Manual Recording, press the Record button ( ● ) on the remote control or the RECORD - M button on the wireless receiver so the blue LED does NOT appear on the wireless receiver.
   • If the system is in Motion Recording, press the RECORD—A/Motion button until the blue LED does NOT appear on the wireless receiver.

2 Select a channel (1~4) from the remote control.
   OR
   Press the CHANNEL A button on the remote to enable Auto Sequence Viewing Mode.

3 When the Start Time arrives, recording begins. The “REC” indicator appears on-screen.

NOTE: You cannot use Quad Mode with Scheduled Recording.

Stopping Schedule Recording

When the Stop Time arrives, the system stops recording. If necessary, you can stop Schedule Recording manually.

To stop Schedule Recording:

1 Press the Record button ( ● ) on the remote control to stop schedule recording.

NOTE: If you stop Schedule Recording, you cannot resume Schedule Recording. You will need to enter new Start and Stop times in the Schedule Record menu.

NOTE: “AUTO REC” must not appear on the receiver in order for Schedule Record to function.

When Should I Use Schedule Recording?

• It is recommended to use Schedule Recording for capturing a sensitive or important target that needs to be recorded daily, i.e., a cash register, safe, shipping & receiving docks, etc.
• During the day in high traffic environments
**Motion recording**
Use Motion Recording to have the system only record when motion is detected by one of the cameras. The camera that appears on-screen is the only camera that is recording. The maximum range on the PIR sensor is 21 feet (6.5 meters).

To enable Motion Recording:

**Prerequisite:** Insert an empty SD card into the receiver.

1. **During live view,** press the Motion button on the remote control.
   - A blue LED will light up beneath RECORD—A on the receiver.

2. **Perform one of the following:**
   - **Enable Quad Mode (recommended):** Press the Quad button on the remote. When motion is detected, the system will display the triggered camera on-screen. When motion recording is complete, the view will return to Quad Mode.
   - **Enable Auto Sequence Viewing Mode:** Press the CHANNEL—A button on the remote. When motion is detected, the system will display the triggered camera on-screen. When motion recording is over, Auto Sequence Viewing Mode will continue as normal.
   - **Change channels manually:** Press the CHANNEL—M button on the wireless receiver or remote control to select a channel.

3. **Press the Motion button on the remote again to stop Motion Recording.** “AUTO REC” will turn off on the receiver.

   - The “REC” indicator will only appear when motion is detected by one of the cameras on-screen.

   - By default, the system is set to record for 15 seconds after the triggered motion event. For details on adjusting the motion recording time, see “Record Time” on page 21.

**Recording Tip:**
If you are using more than one camera, it is highly recommended to use Quad Mode with Motion Recording. Quad Mode allows you to see all four cameras at once. When motion is detected, the triggered camera will appear on-screen. After motion recording is complete, the receiver will return to Quad Mode.

---

**ATTENTION**
If you manually select a channel while the system is in Motion Recording Mode, motion recording will ONLY apply to the selected channel. For example, with Motion Recording enabled, you manually select channel 3; if motion were to occur in view of camera 1, the system would NOT RECORD video from channel 1.
**Viewing Recorded Video**

With video recorded on the SD card, you can open the File menu to playback the video files.

**ATTENTION**
All recording must be stopped on the system prior to playing back saved video files.

You can playback recorded video on the system (when connected to a TV or monitor) or directly from the SD card - simply connect the SD card to your computer.

**Viewing Video Using the System**

To playback recorded video on the system:

1. Stop all recording on the system.
2. Press the Enter button on the remote. The File menu opens.
3. Select the VIDEO folder and press Enter button on the remote.
4. Select a folder and press the Enter button on the remote. Folders are labeled by date (ymmd): e.g. 080512. Select [.] and press the Enter button on the remote to go up a level.
5. Select a file from the list and press the Enter button on the remote. The selected file loads and playback begins.

**Tip:**
Press LEFT and RIGHT to change pages to find video files quickly.

**Controlling Playback**

Once the file begins playing, use the buttons on the remote control or wireless receiver to control playback.

- **Play/Pause playback; restart video from the beginning.**
- **Fast forward playback 2X, 4X, 8X, 16X, 32X, and 64X.** During fast-forward, press Play/Pause to pause and then press Play/Pause again to play.
- **Stop playback.**
- **Rewind playback 1X, 2X, 4X, or 8X.** During rewind, press Play/Pause to pause, then press Play/Pause again to play.
- **Volume +/- : Press to increase/decrease volume during playback.**
- Press the MENU button to return to the file list.
Viewing Video Directly From the SD Card

You can view the saved video files on your computer (PC or Mac) by using an SD card reader (not included). Saved video files are in AVI format.

**NOTE:** Some PCs and Macs may have an SD card reader built-in. Please refer to your computer’s instruction manual for more details.

**PC**

**ATTENTION**
The XviD, DivX, or FFDSHOW codec is required if attempting to view the video files in Windows Media Player™. You can also view AVI files natively in other media players such as VLC and DivX Player.

**To playback recorded video on a PC:**

1. Remove the SD card from the wireless receiver by gently pushing on the SD card. The SD card will pop out from the slot.

2. Insert the SD card into an SD card reader (not included) connected to your PC. Your PC should load the SD card as a new Removable Drive.

3. View files and folders on the SD card. You should see a folder labeled “VIDEO.”

4. Open the VIDEO folder and then open one of the Date folders (yymmdd). The AVI file list appears.

5. Double-click any of the AVI files. The video will begin playing in your default AVI media player.

**MAC**

**ATTENTION**
Additional codecs are required if attempting to view AVI files in QuickTime. VLC Player is recommended for viewing AVI files on a Mac. VLC is an open-source freeware application available at www.videolan.org.

**To playback recorded video on a Mac:**

1. Remove the SD card from the wireless receiver by gently pushing on the SD card. The SD card will pop out from the slot.

2. Insert the SD card into an SD card reader (not included) connected to your Mac. Your Mac should load the SD card as a new Disk Image.

3. View files and folders on the SD card. You should see a folder labeled “VIDEO.”

4. Open the VIDEO folder and then open one of the Date folders (yymmdd). The AVI file list appears.

5. Double-click any of the AVI files. The video will begin playing in your default AVI media player.

For details on deleting files on the system, see “Appendix E: Deleting Video Files on the System” on page 32.
Using the Main Menu

Use the Main Menu to configure camera and receiver settings.

To open the Main Menu:
• Press the MENU button on the wireless receiver or the remote control.

NOTE: Make sure the display is in single channel full-screen view prior to opening the Main Menu.

NOTE: If a power failure occurs on your system, you may need to re-configure your settings. For more details, see “Appendix G: Power Failure Indicator” on page 34.

Camera On/Off
Use the Camera On/Off menu to show/hide camera channels on the main display screen. For example, if you disable camera 3, it will not appear in single channel full-screen, or in Quad mode.

NOTE: Make sure cameras are properly connected and paired to the receiver before disabling.

To enable/disable cameras:
1 From the Main Menu, select Camera On/Off and press the Enter button on the remote.
2 Select the desired camera and press RIGHT/LEFT to select On or Off.

NOTE: The currently selected camera will have On/Off highlighted in RED.
3 Press the Enter button on the remote.
4 Press the MENU button on the remote to exit.

NOTE: Any disabled channels will be blacked out in Quad mode.

Record
Use the Record menu to change image quality, motion recording time, set a recording schedule, and enable/disable overwrite.

The Record menu contains the following sub-menus:
• Quality: Set the image resolution to 320x240 (QVGA) or 640x480 (VGA)
• Record Time: Set the recording time when motion is detected by a camera
• Schedule Record: Set start and stop times for automatic recording
• Overwrite: Enable/disable overwrite of the SD card
Quality

To change the image quality:
1. From the Main Menu, select Record and press the Enter button on the remote.
2. From the record menu, select Quality and press the Enter button on the remote.
3. Press LEFT/RIGHT to select 320x480 (QVGA) or 640x480 (VGA).
4. Press the Enter button on the remote to save your settings.
5. Press the MENU button on the remote until all menu windows are closed.

Record Time

Use the Trigger Record menu to set the length of the time for the system to record after motion is detected by a camera.

To change the motion recording time:
1. From the Main Menu select Record and press the Enter button on the remote.
2. From the Record menu select Trigger Record and press the Enter button on the remote.
3. Select 5 seconds, 15 Seconds, or 30 Seconds and press the Enter button.
4. Press the MENU button until all menu windows are closed.

Schedule Record

Use the Schedule Record menu to set start and stop times for Schedule Recording. During this time block, the system will record continuously from one specific camera, or from any cameras in Auto Sequence Viewing Mode.

NOTE: The time uses the 24-hour clock.

To set a recording schedule:
1. From the Main Menu, select Record and press the Enter button.
2. From the Record menu, select Schedule Record and press the Enter button.
3. Press RIGHT/LEFT to move the cursor (yellow); press UP/DOWN to change the hour and the minutes.
NOTE: You need to press RIGHT to move the cursor from Start Time to Stop Time.

4 Press the Enter button on the remote to save your schedule.

5 Press the MENU button on the remote until all menu windows are closed.

6 Disable Manual and Motion Recording on the system.

NOTE: Motion Recording will override schedule recording. For details, see “Schedule Recording” on page 15.

NOTE: You cannot enable Schedule Recording if the system is in Quad Mode. For details, see “Quad mode” on page 12.

Overwrite
Use the overwrite feature to have the system overwrite the oldest recorded data on the SD card once the SD card is full.

To enable overwrite:
1 From the Main Menu select Record and press the Enter button on the remote.

2 From the record Menu select Overwrite and press the Enter button on the remote.

3 Select Yes and press the Enter button on the remote.

4 Press the Menu button until all menu windows are closed.

NOTE: If you do not enable Overwrite, the system will prompt you when the SD card is full by two ways: the SD Card icon on the OSD will be solid blue and a blue LED will light up under “FULL” on the wireless receiver. You will need to manually delete files from the SD card or insert a new SD card into the wireless receiver. For details see “Appendix E: Deleting Video Files on the System” on page 32.

Pairing
Use the Pairing menu to pair additional cameras (up to 4) to the system. By default, the camera included with your system is automatically paired to channel 1 on the wireless receiver. The second camera is paired to channel 2 and so forth.

What is pairing?
“Pairing” is an electronic handshake between wireless devices. Wireless devices and components need to be paired in order to communicate with each other.

To pair an additional camera:
1 Connect the camera to a power outlet. Place the camera and receiver within 1 ft of each other.
2 Press **MENU** on the wireless receiver or remote control.

3 From the Main Menu, select **Pairing** and press the **Enter** button on the remote.

4 Select Camera 2, Camera 3, or Camera 4 and press the **Enter** button on the remote.

   **NOTE:** By default, the camera included with your system is paired as Camera 1 (channel 1).

5 Following the on-screen prompt, press the **Pair** button on the rear panel of the camera. You have 30 seconds to press the PAIR button on the camera. Once paired, the camera will be immediately displayed on-screen.

   **NOTE:** If you do press the Pair button on the camera during the 30 second pairing window, repeat steps 2–5 to try the pairing process again.

### Settings

Use the Settings menu to set the system time, change display options, and format the SD card.

The Settings menu contains the following sub-menus:

- **Date & Time:** Set the date and time on the system
- **AV Out:** Select the TV system for audio/video output
- **Zoom:** Set 1X or 2X digital zoom on cameras
- **Brightness:** Adjust screen brightness level
- **Format Memory:** Format the SD card
- **Factory Reset:** Restore the system to factory settings
Date & Time

Use the Date & Time menu to set the time and date on the system. You must set the date and time in order to use Schedule Recording. For details, see “Schedule Recording” on page 15.

To set the date and time:
1. From the Main Menu, select Setting and press the Enter button on the remote.
2. From the Setting menu, select Date & Time and press the Enter button on the remote.
3. Press RIGHT/LEFT to move the cursor; press UP/DOWN to change the year, month, day, hour, minutes, and seconds.
   NOTE: The system uses a 24-hour clock.
4. Press the Enter button on the remote to save your settings.
5. Press the MENU button on the remote until all menu windows are closed.

Brightness

Use the Brightness menu to adjust the brightness level.

To adjust brightness:
1. From the Main Menu, select Setting and press the Enter button on the remote.
2. From the Settings menu, select Brightness and press the Enter button on the remote.
3. Press LEFT/RIGHT to increase and decrease the brightness.
4. Press the Enter button on the remote to save your settings.
5. Press the MENU button on the remote until all menu windows are closed.
AV Out
Use the AV out menu to select the TV system for the wireless receiver.

To select the TV system:
1. From the Main Menu, select Setting and press the Enter button on the remote.
2. From the Settings menu, select AV out and press the Enter button on the remote.
3. Select NTSC (North America) or PAL (UK/Europe) and press the Enter button on the remote.
4. Press the MENU button on the remote until all menu windows are closed.

Zoom
Use the zoom menu to enable 1X and 2X digital zoom on the cameras. While zoomed in, you can scan the image and view channels in full-screen.

NOTE: Zoom is intended as a temporary setting that is applied to ALL CHANNELS. When you are finished using zoom, you should return the view to 1X view.

To set the zoom:
1. View camera 1, 2, 3 or 4 in single-channel full-screen.
2. From the Main Menu, select Setting and press the Enter button on the remote.
3. From the Settings menu, select Zoom and press the Enter button on the remote.
4. Select X 1 or X 2 and press the Enter button on the remote.
5. Press the MENU button until all menu windows are closed. The selected camera will be shown on the main display in 2X zoom.

While zoomed in you can perform the following:
- Press LEFT/RIGHT/UP/DOWN to scan the image.
- Press the CHANNEL-M button on the remote to change channels manually (you can only change channels using the CHANNEL-M button while zoomed in)
- Press CHANNEL-A to enable Auto Sequence
- Press the Record button (●) to start/stop manual recording
- Press the Quad button on the remote to view Quad mode - all channels will be zoomed-in

To disable zoom:
1. Open the Zoom menu.
2. Select X 1 and press the Enter button on the remote.
3. Press the MENU button on the remote until all menu windows are closed.
Using the Main Menu

Format
Use the Format menu to format the SD card. It is highly recommended to format the SD card prior to initial recording.

ATTENTION
Formatting erases all data on the SD card. This step cannot be undone.

To format the SD card:
1 Insert the SD card into the SD card slot on the wireless receiver until you hear a "click." Please insert the card according to the diagram on the panel.
2 From the Main Menu, select Setting and press the Enter button on the remote.
3 From the Settings menu, select Format and press the Enter button on the remote.
4 Select Yes and press the Enter button on the remote. Please allow a few moments for formatting to finish. Formatting time will vary depending on the size of the SD card.

Factory Reset
Use the Factory Reset menu to restore the system to factory settings.

NOTE: Restore factory settings DOES NOT delete video files on the SD card, nor does it reset the date and time on the system.

To restore factory settings:
1 From the Main Menu, select Setting and press the Enter button on the remote.
2 From the Settings menu, select Factory Reset and press the Enter button on the remote.
3 Select Yes and press the Enter button on the remote.
4 Press the MENU button on the remote until all menu windows are closed.
### General

<table>
<thead>
<tr>
<th>Description</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Frequency</td>
<td>ISM 2,400–2,483.5 MHz</td>
</tr>
<tr>
<td>Transmission Power</td>
<td>14dBm</td>
</tr>
<tr>
<td>Unobstructed Effective Range</td>
<td>450ft / 135 m (line of sight)</td>
</tr>
<tr>
<td>Spread Spectrum</td>
<td>FHSS</td>
</tr>
<tr>
<td>Modulation Mode</td>
<td>GFSK</td>
</tr>
<tr>
<td>Operating Temperature</td>
<td>14 ~ 122° Fahrenheit / -10 ~ +50° Celsius</td>
</tr>
<tr>
<td>Operating Humidity</td>
<td>&lt; 85%</td>
</tr>
</tbody>
</table>

### Camera

<table>
<thead>
<tr>
<th>Description</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Sensor</td>
<td>CMOS</td>
</tr>
<tr>
<td>Total Picture Pixels</td>
<td>640 x 480pxl (NTSC)</td>
</tr>
<tr>
<td>Minimum Illumination</td>
<td>0Lux (IR on)</td>
</tr>
<tr>
<td>Night Vision Distance</td>
<td>40 FT</td>
</tr>
<tr>
<td>PIR Range</td>
<td>21 FT</td>
</tr>
<tr>
<td>View Angle</td>
<td>Diagonal 52°</td>
</tr>
<tr>
<td>Power Consumption (Max.)</td>
<td>Max 350mA</td>
</tr>
<tr>
<td>Power Supply</td>
<td>9V DC</td>
</tr>
<tr>
<td>Dimensions (W x D x H)</td>
<td>75mm x 110mm x 190mm / 2.9” x 4.3” x 7.5”</td>
</tr>
<tr>
<td>Weight</td>
<td>0.60 lbs / 0.27 kg</td>
</tr>
</tbody>
</table>

### Receiver

<table>
<thead>
<tr>
<th>Description</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported Resolution</td>
<td>640 x 480 @ 10fps or 320 x 240 @ 25fps</td>
</tr>
<tr>
<td>Receiving Sensitivity</td>
<td>-81dBm</td>
</tr>
<tr>
<td>Power Consumption (Max.)</td>
<td>160mA</td>
</tr>
<tr>
<td>Power Supply</td>
<td>9V DC</td>
</tr>
<tr>
<td>Dimensions (W x D x H)</td>
<td>135 mm x 80 mm x 87 mm / 5.3” x 3.2” x 3.5”</td>
</tr>
<tr>
<td>Weight (with wireless antenna)</td>
<td>0.40 lbs / 0.18 kg</td>
</tr>
</tbody>
</table>
Appendix B: About Digital Wireless Technology

The Digital Wireless signal transmission type used by the Lorex LW292 series is also known as FHSS -Frequency Hopping Spread Spectrum. This type of signal is highly resistant to deliberate jamming as it generates a channel hopping sequence using an algorithm generated by the receiver system.

The 2.4GHz (2.400-2.480GHz) band is being divided into sections or paths of 2MHz per section, and each second the transmission signal hops hundreds of times in a specified sequence within this frequency range. The overall bandwidth required for frequency hopping is much wider than 2MHz however because transmission occurs only on a small section of this bandwidth at any given time, the signal being transmitted does not suffer from greatly reduced signal degradation and also avoids blocked paths other devices who act as sources of competing signals. The strength of the signal being transmitted is set to be from 13.5-16dBm, which is much higher than the analog transmission signal allowed by authorities around the Globe.

When an image is captured by the camera it is instantly converted from an analog to digital signal and packaged into small packets. With each successful transmission via the 2 MHz paths discussed above, the packets of information containing images are delivered to the receiver and decoded into analog information. The information can then be displayed on devices that are connected to the wireless receiver (RX).

A device pairing process is required to synchronize the transmitter (TX, Camera) and the receiver (RX). This allows the transmitter and receiver to be on the same frequency and use the same algorithm for frequency hopping. This ensures that only the paired transmitter and receiver can maintain communication signal by hopping to the same frequency paths at the exact same time. As a result, the chance that other devices within the same frequency range are on the same frequency, at the same time and in the same order is extremely unlikely. Note that the pairing process is already done at the factory for products that ship within the same packaging. Only when add-on devices are purchased is a pairing process required.
Appendix C: Adding Cameras

The system comes with camera(s) that have already been paired to the receiver. The Pairing Function assigns each camera to a different channel on the wireless receiver (up to four cameras), and is necessary for configuring additional cameras.

**NOTE:** To order additional cameras, order part number LW2711AC1.

By default, the camera included with your system is automatically paired to channel 1 on the wireless receiver. The second camera is paired to channel 2 and so forth. See channel label on the bottom of the camera to check which channel it has been set to.

It is highly recommended to pair the cameras to the receiver before permanently mounting the cameras.

**To pair an additional camera:**

1. Connect the new camera to a power outlet. Place the camera and receiver within 1 ft of each other.
2. Press **MENU** on the wireless receiver or remote control.
3. From the Main Menu, select **Pairing** and press the **Enter** button on the remote.
4. Select a channel and press the **Enter** button on the remote.

   **NOTE:** If you pair a new camera to a channel which is already being used by an existing camera, the new camera will be connected to that channel. The old camera will automatically be disconnected.

5. Following the on-screen prompt, press the **Pair** button behind the camera. You have 30 seconds to press the **Pair** button on the camera. Once paired, the camera will be immediately displayed on-screen.

   **NOTE:** If you do press the Pair button on the camera during the 30 second pairing window, repeat steps 2–5 to try the pairing process again.
Appendix D: Strengthening the Range of the Wireless Signal

**DISCLAIMER:** Certain accessories are not available in all markets.

There are several ways to boost your wireless signal as well as options to help you extend the range of the wireless signal.

**Clear Line-of-Sight**

The digital wireless signal is virtually interference free. However, you should always ensure there is a clear line-of-sight between the camera and the receiver.

![](image)

**Obstacles**

There should be little to no obstacles obstructing the line-of-sight between the camera and the receiver. Solid objects, such as concrete and metal may limit the range of the wireless signal.

**Extending Your Wireless Signal**

Even with a clear line-of-sight between your camera(s) and your receiver, you may experience a lower video frame rate simply due to the distance between your wireless devices.

Accessory antennas are available that can help extend the range of your wireless signal.
2.4 GHZ Directional Wireless Panel Antenna
Use the 2.4GHz Directional Wireless Panel Antenna (model #: ACCANTD9) to focus a wireless signal onto one specific camera in order to increase range of transmission (clear line-of-sight between the camera and the antenna is required). A 20 ft. extension cable is included help with proper position of the antenna.

2.4 GHZ Omni-Directional Wireless Antenna
Use the 2.4GHz Omni-Directional Wireless Antenna (model #: ACCANTO9) to extend the range and boost the signal of several wireless cameras. You should position the Omni-Directional Wireless Antenna in an elevated position to provide a clear line-of-sight to the cameras. A 20 ft. extension cable is included help with proper position of the antenna.

Visit www.lorextechnology.com for more details on wireless antennas and accessories.
Appendix E: Deleting Video Files on the System

You can delete video files on the SD card directly on the system. Deleting files if you need to clear space on the SD card (if Overwrite is disabled), or for your own file management purposes. For details, see “Overwrite” on page 22.

![Image of file management interface]

**To delete files on the SD card:**
1. From live viewing, press the **Enter** button on the remote. The File menu opens.
2. Select the **VIDEO** folder and press the **Enter** button on the remote.
3. Select a Date folder and press the **Enter** button on the remote. The file list opens.
4. Select a file and press the **Scan/Dec** button on the remote.
5. At the prompt, select **YES** and press the **Enter** button on the remote. The file is deleted and the File List returns as normal.
6. Repeat steps 3–5 for other files on the SD card.

**NOTE:** You cannot delete folders on the SD card using the system.

**ATTENTION**

Use caution if attempting to delete folders on the SD card using your computer. Deleting folders may affect your access to other files on the card or may affect normal operation of the SD card with the system. If you want to delete the contents of the SD card, it is highly recommended to format the card using the system. For details, see “Format” on page 26.
Appendix F: Estimated Recording Times on SD Cards

Use the table below to help you estimate the recording times on various sizes of SD cards. Times shown are in hours, minutes, and seconds.

**NOTE:** The system is compatible with SD High Capacity (SDHC) cards, minimum Class 2. Using higher class SD memory does not ensure better performance.

<table>
<thead>
<tr>
<th>SD Card Capacity</th>
<th>QVGA 320x240</th>
<th>VGA 640x480</th>
</tr>
</thead>
<tbody>
<tr>
<td>512 MB</td>
<td>1:20:22</td>
<td>0:54:18</td>
</tr>
<tr>
<td>1 GB</td>
<td>2:32:05</td>
<td>1:46:24</td>
</tr>
<tr>
<td>2 GB</td>
<td>5:02:47</td>
<td>3:47:17</td>
</tr>
<tr>
<td>4 GB</td>
<td>10:15:24</td>
<td>7:02:13</td>
</tr>
<tr>
<td>8 GB</td>
<td>17:58:28</td>
<td>14:05:01</td>
</tr>
<tr>
<td>16 GB</td>
<td>34:54:25</td>
<td>28:10:35</td>
</tr>
</tbody>
</table>
Appendix G: Power Failure Indicator

A power failure may interrupt recording modes on the system. After power is restored, the following will occur:

- The system will restart in **Auto Sequence Mode + Motion Recording** - this ensures that some form of recording will be immediately active on the system.

**NOTE:** If you had a different display view or recording mode set when the power failure occurred, you will need to re-apply the previous display view and recording mode.

- A flashing Power Failure icon ( ) appears on-screen. The Power Failure icon indicates that a power failure occurred **while the system was actively recording** (i.e. "REC" icon was on-screen)

**NOTE:** The flashing icon appears only if the system was actively recording when the power failure occurred. The flashing icon will disappear when you press buttons on the receiver or remote control.
Appendix H: Viewing your camera remotely using Skype on a PC

Connecting to your video monitor through Skype is a convenient and free* method to view your camera from anywhere with an internet connection.

**NOTE:** When remotely connecting to your video monitor using Skype, recording is disabled.

**How it works**
Your computer connects to the Skype server. The Skype server is connected to your home computer. Your home computer connects to the video monitor, which captures video from the camera.

**System Requirements**

**iPhone, iPad, iPod Touch Requirements**
- *Skype* for iPhone v. 3.0 and above
- *Skype* for iPad v. 3.5 and above
- iPhone 4S/4/3GS
- iPod Touch (3rd generation and above)
- iPad (1st generation and above)
- iOS v. 4.0 and above

For the latest device compatibility list, visit [www.lorextechnology.com](http://www.lorextechnology.com)

**PC Requirements**
- Skype for Windows version 4.2 and above
- Windows 7/Vista/XP SP2
- 1 Ghz or greater processor

**High speed internet connection**
You must have a high-speed Internet connection to use the video function on Skype. Video quality depends on bandwidth and network traffic. Traffic congestion may result in choppy video.

**Disclaimers**

**Mobile Data Charges**
When using a mobile cellular network, data charges may apply. Check with your provider for details.

*Computer to computer*

For Skype related support, visit [https://support.skype.com/](https://support.skype.com/)
Connecting to Skype on a PC

Step 1 of 5: Installing the camera driver
You will need to install the camera drivers located on the software CD (included).

To install the camera drivers:
1. Insert the software CD into the computer. An autoplay window opens.
2. Click Run Lorex.exe.
3. Click the USB Driver button, then click USB Driver. The driver will appear on your desktop.
4. Click the X button to close the window.
Appendix H: Viewing your camera remotely using Skype on a PC

5 Double-click the **Usbdriver** icon on your desktop.

6 Follow the on-screen instructions to complete the driver installation.

---

**Step 2 of 5: Connecting the Receiver to the PC**

**Prerequisite:** Connect the receiver to your TV/DVR.

1 Turn on the camera first, then the Receiver. **Make sure you can see a video image on channel 1.**

   **NOTE:** Pair the camera that is most important for you to view remotely, to Channel 1.

2 Connect the USB cable (included) to your receiver and into the computer’s USB port. The following message will display on screen: "USB PC CAMERA MODE"
Step 3 of 5: Creating a Skype account
A Skype account allows you to connect to your camera through the Skype service. Skype is a service that allows users to make voice calls and video calls to anywhere in the world.

In order to connect to your video monitor using Skype, you will need two accounts---one for the camera (i.e. Lorex Camera) and one for yourself (i.e. Tom Smith).

NOTE: The Skype illustrations and instructions below serve as a guideline only. Skype may change their website / product interface without prior notice.

If you do not have a Skype account
See “If you do not have a Skype account” on page 43.

If you have an existing Skype account
You will have to create a separate account for your camera. Follow the instructions below.

1. Launch Skype. If you are connected to Skype, click Skype > Sign Out.
2. From the Skype Login window, click Don’t have a Skype name?

   ![Click “Don’t have a Skype name?”](image)

3. Follow the on-screen instructions to create a new camera account (i.e. Lorex Camera) or an account for yourself (i.e. Tom Smith).
4 Upon login, click the **See my video** button to confirm that Skype detects the camera.

5 Click the **Close** button to exit.

**NOTE:** If you do not see the “See my video” button, click **Tools** → **Options** → **Video Settings**. Make sure you can see video in the window. Click **Save** to exit.
Appendix H: Viewing your camera remotely using Skype on a PC

6 Click on **Tools > Options**.

7 Click the **Calls** button (📞).

8 Click the **Show advanced options** button.

9 Select the "Answer incoming calls automatically" checkbox and the "Start my video automatically when I am in a call" check box. Click **Save**.
Step 4 of 5: Send a contact request

Next, you have to send a friend request to your personal account (i.e. Tom Smith).

1. Click the **Add a contact** button.

2. Search for the name of your personal account (i.e. Tom Smith), and then click the **Add** button.

3. Click **Send Request**.
Step 5 of 5: Test the connection

**NOTE:** This step requires you to log in to Skype from a *different computer* or *compatible mobile device*.

1. Log in to your personal account (i.e. Tom Smith).
2. A “new contact” pop-up appears. Click the new contact request icon that appears on the bottom-right corner of the window.
3. Click the **Add to Contacts** button to add the camera to your contact list.
4. From the contact list, right-click on your camera’s account name (i.e. Lorex Camera), and click **Call**.
   - The video call begins automatically.
Appendix H: Viewing your camera remotely using Skype on a PC

If you do not have a Skype account
Create your personal account first (i.e. Tom Smith), then create a second account for your camera (i.e. Lorex Camera).

Create a personal account (i.e. Tom Smith):
1. Go to www.skype.com, and click on Join Skype.
2. Click Create Account. Fill in the appropriate fields.
3. Click the I Agree - Continue button.
4. Follow the on-screen instructions to download and install Skype on your computer.
5. Once you are logged in to Skype, click on Skype→Sign out, then see “If you have an existing Skype account” on page 38.
For your convenience, write down your Skype information:

"Personal" Skype account
(i.e. Tom Smith)

Skype Name:
Password:
Email address used to register this account (used for account retrieval):

"Camera" Skype account
(i.e. Lorex Camera)

Skype Name:
Password:
Email address used to register this account (used for account retrieval):

Changing the camera view on Skype

NOTE: This section is applicable only if you have more than 1 camera.

Pair the camera that is most important for you to view remotely, to Channel 1. When you connect the USB cable to the receiver, the receiver defaults to Camera 1, even if you have a different channel selected.

NOTE: You can only view one camera at a time

NOTE: Viewing through Skype does not allow you to change channels remotely, however, you can change the channel manually by using the receiver (see below for details).

To change the camera view:
- From your video monitor, press the CHANNEL M button to change the camera number.
- The camera number changes from “CAM 1” to “CAM 2”.

M button
Viewing a camera on your mobile device
You can remotely monitor your camera on Skype on supported mobile devices.

Supported Devices
- Skype for iPhone v. 3.0 and above
- Skype for iPad v. 3.5 and above
- iPhone 4S/4/3GS
- iPod Touch (3rd generation and above)
- iPad (1st generation and above)
- iOS v. 4.0 and above

For the latest device compatibility list, visit [www.lorextechnology.com](http://www.lorextechnology.com) and visit the product page.

Prerequisites
- Install and configure the PC/Mac Skype software. For details, see “Appendix H: Viewing your camera remotely using Skype on a PC” on page 35 or see “Appendix I: Viewing your camera remotely using Skype on a Mac” on page 46.
- Ensure you configure your camera’s Skype account to auto-accept incoming calls. For details see step 6–9 on page 40 (PC) or see “Step 4 of 6: Configuring Skype” on page 48 (Mac).

To view your camera on a mobile device:
1. Download and install the mobile Skype application from the mobile application store (i.e. App Store for the iPhone).
2. Launch Skype and tap Contacts.
   **NOTE:** The video monitor’s account may be under “All Contacts”.
3. Select the video monitor’s account, and tap Call to connect to the camera.
Appendix I: Viewing your camera remotely using Skype on a Mac

USB Drivers are available as a free download from www.lorextechnology.com to connect your Live SD Series device to a Mac computer for remote viewing through Skype.

**How it Works**

Your computer connects to the Skype server. The Skype server is connected to your home computer. Your home computer connects to your device, which captures video from the camera.

NOTE: When remotely connecting to your device using Skype, recording is disabled.

NOTE: Audio monitoring and 2-way audio are not supported through Skype.

**System Requirements**

**Mac Requirements:**
- Skype for Mac OS v. 5.3 and above
- Mac OS v. 10.5.8 and above
- 1 GHz or higher Intel processor
- PowerPC™ not supported

**iPhone, iPad, iPod touch Requirements:**
- Skype for iPhone v. 3.0 and above
- Skype for iPad v. 3.5 and above
- iPhone 4S/4/3GS
- iPod Touch (3rd generation and above)
- iPad (1st generation and above)
- iOS v. 4.0 and above

For the latest device compatibility list, visit www.lorextechnology.com
Appendix I: Viewing your camera remotely using Skype on a Mac

Viewing your camera remotely through Skype

Step 1 of 6: Installing USB Drivers for Mac OS:
Mac drivers are available as a free download from www.lorextechnology.com.

1. Download the USB Driver for Mac from the Updates section of the product page for your device.
2. Double-click the .zip file to extract the contents.
3. Open the folder SD Series Mac Driver and double-click the WirelessCameraMacDriverSuiteInstaller (.pkg) file.
4. Follow the on-screen instructions to install.

Step 2 of 6: Connecting the receiver to your computer:
1. Turn on your camera first, and then turn on your video monitor or receiver. Make sure you can see a video image on Channel 1.

   NOTE: Pair the camera that is most important for you to view remotely to Channel 1.
2. Connect the mini-USB cable (included) from the USB port on your video monitor or receiver to an available USB port on your computer.
   • If your device is connected to a TV or DVR, “USB PC CAMERA MODE” appears on the screen.

Step 3 of 6: Creating a Skype account:
A Skype account allows you to connect to your camera through the Skype service. Skype is a service that allows users to make voice and video calls to anywhere in the world.

In order to connect to your video monitor using Skype, you will need two accounts—one for the camera (i.e. Lorex Camera) and one for yourself (i.e. Tom Smith).

   NOTE: The Skype illustrations and instructions below serve as a guideline only. Skype may change their website / product interface without prior notice.

If you do not have an existing Skype account:
See “If you do not have an existing Skype account...” on page 52.
Appendix I: Viewing your camera remotely using Skype on a Mac

If you have an existing Skype account:
You have to create a separate account for your camera. Follow the instructions below.

1. Launch Skype. If you are already connected to Skype, click File→Sign Out.
2. Click Create New Account.
3. Follow the on-screen instructions to create a new account.

Step 4 of 6: Configuring Skype

1. Upon login, click Skype→Preferences. Select the Audio/Video tab.
2. Under Camera, select Wireless Monitoring System if it is not already selected. You will see live video from your camera if your device is connected.
Appendix I: Viewing your camera remotely using Skype on a Mac

- If the video area is black, check to see if your camera is on and is paired to Channel 1. Also check to make sure your video monitor or receiver is connected to your computer.

**NOTE:** When connecting or reconnecting your video monitor or receiver, you must close the Preferences window and re-open it to the Audio/Video tab to test the video connection.

3 Select the **Calls** tab.

4 Under Incoming Calls, select **Answer Automatically**.

5 Check **Start video automatically at the beginning of call**.

6 Select the **Privacy** tab.
7 Under **Allow calls from**, select **Contacts**. This will prevent the device from accept Skype calls from anyone who is not in the contact list for its account.

![Privacy tab](image)

**NOTE:** You may also select **Anyone**, which will allow anyone with a Skype account to call the device and access your camera. This setting is not recommended.

8 Close the Preferences window to return to the main Skype window.

**Step 5 of 6: Send a contact request**

Next, you have to send a friend request to your personal Skype account (i.e. Tom Smith).

1 From the main Skype window, click **Add Contact**.

![Add Contact](image)
Appendix I: Viewing your camera remotely using Skype on a Mac

2 Under Add Contact, enter the Skype account name (i.e. Tom Smith) or email address for your personal Skype account. Click **Find**. Your personal Skype account should appear below the search bar.

3 Next to your personal Skype account, click ![Contact Request](contact.png) and then click **Send** to send the contact request.

**Step 6 of 6: Test the connection**

**NOTE:** This step requires you to log in to Skype from a different computer or compatible mobile device.

1 Log in to your personal account (i.e. Tom Smith).

2 The contact request from your device’s Skype account should appear in the left column under Recent. Click the Skype account name for your device.

3 Click **Accept**.

4 Click the ![Make a Voice Call](call.png) button to call your camera. The video call begins automatically. Please allow around 15 to 25 seconds for the video connection to be established.

**NOTE:** You can also call the camera from the contact list using the **Call** button. Do not use the Video Call button.

**NOTE:** Video may appear pixelated immediately after connecting. It should improve within a few seconds, depending on your Internet connection.
Appendix I: Viewing your camera remotely using Skype on a Mac

If you do not have an existing Skype account...
Create your personal account first (i.e. Tom Smith), then create a second account for your camera (i.e. Lorex Camera).

1. Go to www.skype.com, and click on Join Skype.

2. Click Create Account. Fill in the appropriate fields.

3. Click the I Agree - Continue button.

4. Follow the on-screen instructions to download and install Skype on your computer.

5. Once you are logged in to Skype, click on Skype→Sign out then see “If you have an existing Skype account:” on page 48.
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>There is no picture from a Camera.</td>
<td>• Check power to the Camera. Make sure the adapter is plugged in and the</td>
</tr>
<tr>
<td></td>
<td>red LED light on the power adapter is on</td>
</tr>
<tr>
<td></td>
<td>• Make sure that the Cameras and Receiver are both ON.</td>
</tr>
<tr>
<td></td>
<td>• Make sure that the camera is in range of the Receiver.</td>
</tr>
<tr>
<td>There is Interference with the Camera Picture.</td>
<td>• Make sure that each camera is within range, and that there are no</td>
</tr>
<tr>
<td></td>
<td>large obstructions or interference</td>
</tr>
<tr>
<td></td>
<td>• Try repositioning the camera, receiver or both to improve the reception.</td>
</tr>
<tr>
<td>The picture is dropping</td>
<td>• Move the camera closer to the receiver.</td>
</tr>
<tr>
<td></td>
<td>• Try repositioning the camera, receiver or both to improve the reception</td>
</tr>
<tr>
<td>The Picture is or has become Choppy</td>
<td>• The picture may become choppy when experiencing a lower frame rate</td>
</tr>
<tr>
<td></td>
<td>(i.e. 10 frames per second vs. a higher 20 frames per second).</td>
</tr>
<tr>
<td></td>
<td>• Try moving the camera closer to the receiver.</td>
</tr>
<tr>
<td></td>
<td>• Remove obstructions between the Receiver and Camera</td>
</tr>
<tr>
<td></td>
<td>• Try switching to QVGA mode. Resolution will be reduced but video</td>
</tr>
<tr>
<td></td>
<td>frame rate will increase</td>
</tr>
<tr>
<td>The Picture appears to be grainy/distorted</td>
<td>• When using with large screen TV/Monitor especially high-definition</td>
</tr>
<tr>
<td></td>
<td>televisions, the picture might be grainy as the camera limits video</td>
</tr>
<tr>
<td></td>
<td>resolution to VGA (640x480 pixels). This is not a product defect.</td>
</tr>
<tr>
<td></td>
<td>• For best performance use with TV/Monitor PIP [Picture in Picture]</td>
</tr>
<tr>
<td></td>
<td>function. Check your TV/Monitor product manual to see if this feature</td>
</tr>
<tr>
<td></td>
<td>is available on your TV/Monitor</td>
</tr>
<tr>
<td></td>
<td>• View video on a smaller screen TV/Monitor</td>
</tr>
<tr>
<td></td>
<td>• Consider increasing the range of the wireless signal with an accessory</td>
</tr>
<tr>
<td></td>
<td>antenna (page 30)</td>
</tr>
<tr>
<td>The Picture is white</td>
<td>• Common situation know as “washout” or “whitewash” where a strong light</td>
</tr>
<tr>
<td></td>
<td>source is pointed at the camera lens. The camera lens IS NOT harmed</td>
</tr>
<tr>
<td></td>
<td>during a whitewash.</td>
</tr>
<tr>
<td></td>
<td>• DO NOT point your camera towards a light source</td>
</tr>
<tr>
<td>“Er” appears on the on-screen display</td>
<td>• The system has encountered an error with the SD card. Power off the</td>
</tr>
<tr>
<td></td>
<td>receiver, remove then re-insert the SD card, and then power the</td>
</tr>
<tr>
<td></td>
<td>receiver back on</td>
</tr>
<tr>
<td></td>
<td>• If “Er” still appears on the OSD, format the SD card</td>
</tr>
<tr>
<td>The buttons on the receiver don’t work</td>
<td>• The Lock may be engaged. On the right panel of the receiver, slide the</td>
</tr>
<tr>
<td></td>
<td>lock away from the SD card slot</td>
</tr>
<tr>
<td></td>
<td>• If the lock is disengaged but the buttons still do not function, power</td>
</tr>
<tr>
<td></td>
<td>the receiver off then power it back on</td>
</tr>
<tr>
<td>The 1, 2, 3, &amp; 4 buttons do not change</td>
<td>• The 1, 2, 3, and 4 buttons jump to their respective channels while in</td>
</tr>
<tr>
<td>channels</td>
<td>Quad Mode; press the CHANNEL-M button on the remote control or the</td>
</tr>
<tr>
<td></td>
<td>receiver to change channels manually</td>
</tr>
</tbody>
</table>
Frequently Asked Questions

**General Questions**

Q: Why can’t I open the main menu, change viewing mode, access recordings, or access any other options while in recording mode?
A: In order to perform any changes on the system while in recording mode, you will need to stop recording. Recording overrides other actions on the receiver.

Q: How do I turn off the Alarm (‘beeping’) sound?
A:
1. Press the **Menu** button on the remote.
2. Navigate to **Setting→Alarm Volume**
3. Press the back (number 4) button repeatedly on the remote to turn the volume all the way down. Note: One volume bar means the alarm sound is muted.
4. Press **Enter** on the remote.

Q: Can I extend the wireless range of the receiver?
A: Yes. There are optional antennas available at [www.lorextechnology.com](http://www.lorextechnology.com) that help boost wireless signals.

Q: While in Quad Viewing mode, how can I quickly go to a specific channel?
A: Press the direction button on the remote that refers to the channel number you want to view.
To now view another channel, repeatedly press the **M** channel button on the remote until you have reached your desired channel.

Q: What happens to the system during a power failure while in recording mode?
A: A power failure may interrupt recording modes on the system. After power is restored, the following occurs:

- The system will restart in Auto Sequence Mode + Motion Recording. This ensures that some form of recording will be immediately active on the system.
- A flashing Power Failure icon will appear on-screen. The Power Failure icon indicates that a power failure occurred while the system was actively recording.

**NOTE:** If you had a different display view or recording mode set when the power failure occurred, you will need to re-apply the previous display view and recording mode.
**NOTE:** The flashing icon appears ONLY if the system was actively recording when the power failure occurred. The flashing icon will disappear when you press buttons on the receiver or remote.

**NOTE:** If a power failure occurs during recording, you may lose video recorded within ten minutes of occurrence of the power failure if set to Manual or Scheduled Recording.

**Q:** What is the maximum distance I can have between the camera and the receiver?

**A:** Typically 450 feet (137 m) with a clear line of sight in open space, or approximately 150 feet (46 m) in a house. Walls, studs, furniture will interfere with the range of wireless transmission. Try repositioning the camera and/or monitor to achieve optimal signal strength. An optional antenna [available at lorextechnology.com](http://lorextechnology.com) may help extend the range and/or get around obstacles.

**Q:** What does ‘line-of-sight’ mean?

**A:** ‘Line-of-sight’ means that there are no obstructions which may interfere with the transmission of the audio/video signal. Obstructions include items such as walls, buildings and certain electronic devices.

**Q:** Why does my “wireless camera” have a power cable?

**A:** The term "wireless" refers to the lack of a video cable between the camera and the receiver. The camera still requires a power source.

**Q:** What is pairing?

**A:** Pairing is an electronic handshake between digital wireless devices. Pairing allows the devices to communicate exclusively with each other. The transmission is secure.

**Q:** Can digital wireless cameras be paired to more than one receiver?

**A:** Digital Wireless cameras can only be paired to one receiver. This is to prevent interception by 3rd parties, and prevents any other device from picking up the signal - this also means that you cannot pair one camera to multiple receivers.

**Q:** What does the flashing power-plug icon mean?

**A:** A power failure occurred while the system was actively recording. Refer to “What happens to the unit during a power failure” for details.

**Q:** What accessories can I add to the system?

You can add extra cameras and a range extender to the unit:

- LW2711AC1 - Accessory Camera
- ACCANTD9 - Accessory range extender antenna for camera ONLY - directional, 9 dBi

For details, see “Appendix D: Strengthening the Range of the Wireless Signal” on page 30.
Frequently Asked Questions

**Screen Saver (Picture Frame Simulation, LW2710, LW2910 Series only)**

**Q: Can I upload my own pictures onto the receiver?**

A: The LW292 does not offer the ability to upload your own pictures/videos. It only displays the pre-loaded images (five scenery images).

**Q: Can I delete the screen saver images (LW2710, LW2910 Series only)?**

A: No. The images are pre-loaded into the monitor, not the SD card. Formatting the SD card will not delete the screen saver images.

**Privacy**

**Q: Is the signal secure?**

A: Yes. The Digital Wireless signal transmission type used by the Lorex LW292 series is also known as FHSS- Frequency Hopping Spread Spectrum. This type of signal is highly resistant to deliberate jamming as it generates a channel hopping sequence using a sophisticated algorithm generated by the receiver system.

**Q: What memory cards is the receiver compatible with?**

The system is compatible with SD (Secure Digital) and SDHC (SD High Capacity) memory cards, minimum Class 2.

**Q: What is the maximum capacity SD memory card supported?**

A: The system supports a maximum of 16 gigabytes.

**Recording**

**Q: Can I view remotely and record at the same time?**

A: No. You can only view during remote viewing. Local recording is disabled.

**Q: Can I record multiple cameras at the same time?**

A: The receiver can only record one channel at a time.

**TIP:** Set Trigger Record in the Record menu to 5 seconds (the lowest possible value), and enable Quad Mode. This allows the system to: a) record a channel for 5 seconds when motion is detected b) Records the next channel that detects motion for another 5 seconds.

**Q: Why can’t I access the main menu while I’m in Quad Mode?**

A: You must exit Quad Mode before you can access the main menu. Simply press Quad on the remote control to exit.

**Q: Can I record in Auto Sequence Viewing Mode?**

A: Yes. Set the system to Scheduled Recording. Then set the viewing mode to Auto Sequence. Note that the recorder only records what it sees on-screen. This means that you will only record video from a particular channel when it is displayed on the monitor.

**Q: Why isn’t scheduled recording starting?**
• Make sure that the SD card is properly inserted into the monitor. Make sure that the SD card icon appears at the top of the screen.
• Double check that you have set the system time. Press the Menu button to access the main menu. Then navigate to Setting ➜ Date & Time to set the system time.
• Double check that you have set the start/stop time in the scheduled recording menu.
• Double check that you have turned scheduled recording on.
• You may be in Quad Mode. Exit Quad Mode before starting scheduled recording. Press the Quad button on the remote to exit.

Q: Can I set specific days of the week for the system to record?
A: You can only specify to record at a particular time of day (for example, everyday from 9:00 a.m to 5:00 p.m).

NOTE: System utilizes a 24-hour clock (i.e 15:00 is 3:00pm).
Use the Schedule Record menu to set start and stop times for Schedule Recording. During this time block, the system records continuously from one specific camera, or from any cameras in Auto Sequence Viewing Mode.

Q: I noticed that the system is recording back to back video files while in Motion Recording setting. Why is that?
A: Reasons for this could be as follows:

1 The camera(s) may be located in a busy area with lots of movement (i.e. side walk). Either A) Change recording setting to Schedule Recording and select a camera which covers the most critical area B) Try to point the camera a bit more downwards so it does not pick up as much of the (foot) traffic.

2 When having more than 1 camera set up, you may have 2 or more cameras pointed at the exact same area (from different vantage points). This causes them to pick up motion at the same time and create back to back recordings. Change the viewing area of one or more cameras so they don’t overlap.

Viewing A/V Output

Q: I have connected the A/V output cable to my TV/monitor. Why does the image not appear on the TV/monitor?
A: You need to press the AV button on the remote to transfer the image from the LW292 to the TV/monitor.

NOTE: It takes approximately 5 seconds for the image to appear on the TV/Monitor.

Q: When using A/V output, can I watch the video on the TV/monitor, and on the LW292 at the same time?
A: When using A/V output, the LCD screen blacks out. The image only appears on the television screen.
**System Settings**

**Q: Can the system display a 12-hour clock?**

A: The unit only displays time in the 24-hour clock format.

**Q: Can the system adjust to daylight savings time?**

A: There is no daylight savings time (DST) setting on the system. DST must be set manually if necessary.

---

**Video Playback**

**Q: Why can't I access the saved video files on my memory card?**

A: All recording must be stopped on the system before playing back saved video files. This also applies to Quad or screen saver viewing mode.

**Q: When using Manual or Scheduled Recording, why does the system generate so many video files?**

A: The system records video files in 10 minute sessions (i.e. 1 hour recording will be divided into 6 separate files.) The reasons for this are as follows:

- It makes finding events easier/faster in case you know the approximate timing of the event.
- The system needs time to record the video file to the memory card. Every time a new 10 minute session starts, the previous 10 minute session is stored onto the memory card.

**Q: How can I view videos on my computer?**

A: Remove the memory card from the monitor and insert it into a compatible SD card reader.

If you are using a PC:

- A window will pop-up asking you whether you would like to browse files on the memory card or launch Windows Media Player™. If the pop-up window does not appear, open My Computer (Vista: Computer) and find the memory card in the list of drives.
- Find the video file you want to view by looking for the date the event occurred. The file name convention indicates the date (“090825” means the file was recorded on August 25, 2009). Double-click the file to begin playback in Windows Media Player™.
- The XviD, DivX, or FFDSHOW codec may be required if attempting to view the video files in Windows Media Player™. You can also view AVI files natively in other media players such as VLC and DivX Player.

If you are using a Mac:

- The memory card folder will appear on the desktop. Double-click the folder to open.
- Find the video file you want to view by looking for the date the event occurred. The file name convention indicates the date: “090825” (year (09), month (08), date (25)) means the file was recorded on August 25, 2009. Double-click the file to begin playback in Quicktime™.
- Additional codecs may be required if attempting to view AVI files in QuickTime. VLC Player is recommended for viewing AVI files on a Mac. VLC is an open-source, freeware application available at www.videolan.org
LOREX PRODUCT LIMITED WARRANTY

Lorex warrants, to the original retail purchaser (the "Purchaser"), that the item (the "Product") is properly used and, when applicable, the CD-ROM on which the accompanying software is provided, is free from defects in materials and workmanship, provided the Product is used in normal conditions and is used in strict accordance with the instructions contained in the documentation for the Product. This warranty shall be for the following warranty periods (the "Warranty Period"), commencing on the date the Purchaser buys the Product at retail in an unused condition:

Parts and Labor: 1 year (Warranted parts do not include Bulbs, LED's and Batteries)

Lorex’s responsibility under this, or any other warranty, implied or expressed, is limited to repair, replacement or refund, as set forth above. These remedies are the sole and exclusive remedies for any breach of warranty. Lorex is not responsible for direct, special, incidental, or consequential damages resulting from any breach of warranty or under any other legal theory including but not limited to, loss profits, down time, loss of use, loss of data and any other costs of recovering, reprogramming or reproducing any program or data stored in or used with a system containing the Product CD-ROM or accompanying software.

Lorex does not warrant that the software will operate with any other software except that which is indicated. Lorex cannot be responsible for characteristics of third party hardware or software which may affect the operation of the software included.

The purchaser may have other rights under state, provincial, or federal laws and where the whole or part of any item of this warranty is prohibited by such laws, it shall be deemed null and void, but the remainder of the warranty shall remain in effect. All expressed and implied warranties are limited in duration to the limited warranty period. No warranties apply after that period. Some states do not allow limitation on how long an implied warranty lasts, so this limitation may not apply to you. Some states do not allow the exclusion or limitation of incidental or consequential damages so the above warranty may not apply to you. This limited warranty gives you specific legal rights and you may also have other rights that vary from state to state.

Exclusions of the warranty

This warranty does not cover any costs relating to removal or replacement of any Product, CD-ROM, or software installed on your computer.

Lorex reserves the right to make changes in design or to make additions to or improvements in its products without incurring any obligation to modify any product which has already been manufactured. Lorex makes no warranty that the Product will function without interruption or otherwise be free of anomalies, errors or 'Bugs'. Lorex makes no warranty with regard to any software provided with the Product unless the software is specifically not for otherwise than for the Product and is used in strict accordance with such instructions. This warranty does not cover any costs relating to repair, removal or replacement of any Product, CD-ROM, or software installed on your computer.

This warranty does not apply to the performance or functionality of any computer software included in the package with the Product. This warranty only covers defects in the CD-ROM media such as a broken or defect in the CD-ROM that would prevent the CD-ROM from being read by your personal computer’s CD-ROM drive. Lorex makes no warranty with regard to any software provided with the Product unless the software is specifically not for otherwise than for the Product and is used in strict accordance with such instructions. This warranty does not cover any costs relating to replacement of any Product, CD-ROM, or software installed on your computer.

This warranty does not cover the performance or functionality of any computer software included in the package with the Product. This warranty only covers defects in the CD-ROM media such as a broken or defect in the CD-ROM that would prevent the CD-ROM from being read by your personal computer’s CD-ROM drive. Lorex makes no warranty with regard to any software provided with the Product unless the software is specifically not for otherwise than for the Product and is used in strict accordance with such instructions. This warranty does not cover any costs relating to replacement of any Product, CD-ROM, or software installed on your computer.

Lorex reserves the right to make changes in design or to make additions to or improvements in its products without incurring any obligation to modify any product which has already been manufactured. Lorex makes no warranty that the Product will function without interruption or otherwise be free of anomalies, errors or 'Bugs'. Lorex makes no warranty with regard to any software provided with the Product unless the software is specifically not for otherwise than for the Product and is used in strict accordance with such instructions. This warranty does not cover any costs relating to replacement of any Product, CD-ROM, or software installed on your computer.

Lorex reserves the right to make changes in design or to make additions to or improvements in its products without incurring any obligation to modify any product which has already been manufactured. Lorex makes no warranty that the Product will function without interruption or otherwise be free of anomalies, errors or 'Bugs'. Lorex makes no warranty with regard to any software provided with the Product unless the software is specifically not for otherwise than for the Product and is used in strict accordance with such instructions. This warranty does not cover any costs relating to replacement of any Product, CD-ROM, or software installed on your computer.

1 Pack the Product in a well-padded sturdy carton.
2. a. Please contact our customer service department to obtain a return authorization number.
   b. Return the unit to: Lorex Returns
      236 Route 49 South, Suite 171, Dock Door 44
      Plainsboro, NJ 08536

3. a. If the unit was purchased in the United States proceed as follows:
   b. Return the unit to: Lorex Returns
      Schneider Logistics
      236 Route 49 South, Suite 171, Dock Door 44
      Plainsboro, NJ 08536

4. a. If the unit was purchased in Canada proceed as follows:
   b. Return the unit to: Lorex Service Center
      55 Industrial Rd.
      Markham, Ont, L3R 3S1

5. a. If the unit was purchased in Europe please visit:
   www.lorexinternational.com for return instructions.

TOLL FREE CUSTOMER SUPPORT
North America: 1-888-4-DLOREX (1-888-435-6739)
International: 800-42-LOREX 0 (800-425-67390)
www.lorextechnology.com

Always use caution when installing video and audio surveillance equipment especially when there is potential privacy. Ignore regarding federal, state and/or local regulations applying to the installation of video and audio recording or surveillance. Private communication may be regulated.

Lorex guarantees the authenticity of the original item purchased and conforms to applicable trademark laws. Lorex reserves the right to modify the design or functionality of any of its products from time to time, without notice to the user. Lorex will not be liable for any consequential or indirect damages resulting from the use of any product purchased from Lorex.

This warranty is not transferable to any other party, and may not be sold or transferred.

Lorex reserves the right to modify the design or functionality of any of its products from time to time, without notice to the user. Lorex will not be liable for any consequential or indirect damages resulting from the use of any product purchased from Lorex.
L’Amérique du nord: 1-888-42-LOREX (1-888-425-6739)
Norteamérica: 1-888-42-LOREX (1-888-425-6739)
Local : 905-940-5355
International : 800-42-LOREX 0 (800-425-67390)

Si el producto no puede ser reparado o reemplazado, se devolverá el valor vigente de los productos o del CD-ROM, según corresponda, dentro de un período igual a la parte no vencida del Período de Garantía del Producto.

Esta garantía no se aplica a los defectos o daños al Producto causados por (i) uso negligente del Producto, (ii) mal uso, abuso, negligencia, alteración, reparación o instalación incorrecta del Producto, (iii) cortocircuitos o corrientes eléctricas transitorias, (iv) uso por el Comprador que no esté de acuerdo con la instalación del producto, (v) uso de piezas de repuesto no suplidas por Lorex (vi) inadecuado mantenimiento del Producto, o (vii) accidente, incendio, inundación u otros accidentes naturales. Esta garantía no cubre el rendimiento o el uso del Producto en una ubicación que no esté en conformidad con los términos de uso del Producto.

Esta garantía es el reemplazo de otras garantías, expresas o implícitas, y Lorex no asume ni autoriza a ninguna otra persona para hacerlas válidas. Lorex no autoriza a ningún representante, detallista o mayorista, a hacer ninguna declaraciones sobre el Producto que creen nuevas garantías o modifiquen esta garantía, o que le otorguen derechos adicionales.

Lorex no hace ninguna de las declaraciones ni garantías de ninguna clase con respecto al producto, su capacidad o eficacia del Producto para evitar, minimizar o en algún forma afectar a los daños o lesiones personales o a la propiedad. Lorex no es responsable por ningún daño personal, en sus ojos o menor relacionado con el Producto o su uso para cualquier daño, sea físico o mental relacionado con el mismo. Cualquier afirmación o declaraciones, sea escrita, hablada o manualmente hecha, no es parte de este Acuerdo de Garantía que es la parte integral de este Acuerdo de Garantía y no puede ser alterado ni cambiado, excepto por un Escritura autorizada por Lorex.

La competencia de Lorex es en el rango de cualquier otra garantía, implícita o explícita, está limitada a la reparación, reemplazo o reembolso, según corresponda, de los daños o daños intangibles, y el comprador no puede recuperar daños especiales, incidentales, o daños indirectos resultantes de un incumplimiento de garantía, daño físico o moral. Lorex no es responsable por daños y perjuicios, expresa o implícita, incluyendo, pero sin limitarse a: pérdida de ganancias, pérdida de ingresos, pérdida de negocios, pérdida de ingresos o beneficios del producto, o daños al producto, a sus elementos o partes, a la propiedad o los derechos de su propiedad, el tiempo de inactividad, la pérdida de uso, la pérdida de valor, la pérdida de productos o la importación de productos, el tiempo de inactividad o si la reparación o reemplazo no se habilita.

Esta garantía no se aplica si el Producto ha sido alterado o reparado por personas no autorizadas por Lorex. Lorex no autoriza a ningún representante, detallista o mayorista a hacer declaraciones sobre el Producto que crean nuevas garantías o modifiquen esta garantía, o que le otorguen derechos adicionales, excepto por un Escritura autorizada por Lorex. En caso de tener cualquier duda sobre si podrás acudir a la garantía, por favor consulta con Lorex Customer Service.

Si se usa la unidad en Europa y desea devolver el producto por favor visite: www.lorextechnology.com para obtener instrucciones.